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Overview of Hyperlinking in Federal Court 
In the internet research world, hyperlinks are a standard way of “drilling down” for 

more detail or specific information.  Just as all web pages contain links to other 

pages, cases downloaded from legal research services such as Westlaw or Lexis 

contain links to the cases, statutes, articles, or other sources cited within the 

opinion.  The links allow immediate access by the reader to these referenced 

materials.   

Attorneys can include links to cited law and CM/ECF filings in their briefs filed in 

CM/ECF, adding another level of persuasion to their writing.  Hyperlinks in briefs 

and other court filings provide quick, easy, and pinpoint access to particular 

sections of a case, or to specific filings in the court’s record.  The attorney can 

thereby highlight the precise issue presented, and the specific evidence and 

controlling or persuasive law the court should consider.   

Hyperlinks in court filings are very beneficial for court chambers.  Court 

submissions which include links to relevant case law and case filings are easy for 

chambers staff to review.  The attorneys’ arguments can be immediately verified 

in the context of the relevant law.  The judge or judicial clerk is able to read the 

text of the cited case law on one screen while reading the attorney’s brief on the 

other.  And if a brief contains links to referenced exhibits, and even to specific 

pages within those exhibits, the judge or judicial clerk can access the relevant 

evidence without having to navigate through the CM/ECF record.  Particularly 

when dealing with large and complex cases, links save chambers considerable 

time and effort.  Links make it easy for the court to verify – and adopt – the 

positions taken by an advocate. 
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Types of Permissible Hyperlinks 
Subject to the local rules of a district, the following types of hyperlinks are 
typically allowed in court documents.  

Type of link Description (and Examples) 

Links to documents previously 

filed on CM/ECF 

 

Links to attachments and 
exhibits being filed with your 

brief 

 

Links to case and statute 

citations 

For example: 

Westlaw, 

 

Lexis, 

or court websites. 

 

Links to Local Rules: 

  

Either to the entire document, 

 

or to the specific page within the document where 
the cited rule is located. 
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Links to Prior CM/ECF Filings 

Drafting Documents to Later Include Links to CM/ECF 
If you intend to include CM/ECF links in a document you are creating, use a  
consistent citation format that cites the CM/ECF filing number along with the 
CM/ECF page number.  For example: 

STEP ACTION 

1 Download the filings from CM/ECF, and save them in your computer.  

Reminder: You can download a document from CM/ECF one time for 
free when you receive the Notice of Electronic Filing.  Charges apply 
to each additional download of the same document. 

2 Documents downloaded from CM/ECF will include a header that 

identifies the CM/ECF filing number and the page numbers within that 
filing. 

 

3 When drafting your brief, cite to the CM/ECF filing number and 

CM/ECF page number to which you are citing.  For example: 

  

Assume you are citing to the following page of evidence. 

 

The citation within the brief could appear as follows: 

The Plan included a Trust Agreement.  (Filing No. 13-1, at CM/ECF p. 3). 

Note:  A consistent citation format is necessary when using CM/ECF 

LinkBuilder (currently under development by Kansas and Nebraska 
courts for nationwide use by attorneys) to add links. 

Gathering Links for Citations to the Record 
Now that the filing numbers and associated page numbers are in the brief, you 
can manually add links to the electronic record as follows:1 

STEP ACTION 

1 Open the CM/ECF docket sheet for the case and scroll to the cited 
docket filing. 

 

                                                   
1
 CM/ECF LinkBuilder is currently being designed as an automation tool for use by counsel in 

adding CM/ECF links.  The projected testing date is August 2013. 
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STEP ACTION 

2 If linking to the main CM/ECF filing, right-click on the docket filing 
number,   

  then,  

 

 

 

 

 

 

If linking to a sub-file within a CM/ECF filing number: 

Either 

Click on the docket filing number;    

 

 

 
A window will open which lists all sub-filings  
for that docket filing number. 

 
 
Place your cursor over the link for the 

document you are citing.  Right-click,  
and from the drop-down menu that appears, 
 

 

Select Copy Shortcut. 

Or 

 

Right-click on the sub-filing number as reflected in the docket text 

 

and, 

 

 

Select Copy Shortcut. 
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Inserting CM/ECF links into your document—Microsoft Word 
To manually add the links you have copied from the docket to the MS Word 
document you are drafting: 

 

STEP ACTION 

1 In the brief, use your cursor to select the citation you want to link. 

 

2 Select the Insert tab on the MS Word ribbon, then select Hyperlink. 
An Insert Hyperlink dialog box will appear. 

 

Note: The text you selected will automatically appear in the “Text to 
display” line. 

3 Place your cursor in the Address box of the Insert Hyperlink dialog 
box. Right-click. From the drop-down that appears, select Paste. 

 

4 The link to the first page of the filing will appear. 

To link to the filing only, or to only page 1 of the filing, click OK. The 
link to the citation will be added in your brief. 
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STEP ACTION 

5 To link to the specific page number of the CM/ECF filing that you are 
citing, 

In the address box, scroll to or place your cursor at the end of the link 
address. 

Add the following text: ?page=<page number> .  For example, 

To link to page number 3 of a filing, add ?page=3.  Click OK and the 
link to the page will be added to the citation in the brief. 

 

Note: Use the page numbers assigned by CM/ECF when linking to 

pages in documents filed in CM/ECF.  Do not use Bates numbers or 
other numbering assigned to the record by the parties. 

Note: While the document remains in an MS Word format, the link will 

go only  to the first page of the document.  But upon conversion to 
PDF (see instructions below), the PDF link will go to the specific page 
you cited. 

6 Convert the brief to a PDF following the instructions below. 

7 File the PDF version of the document in CM/ECF. 

Note: It is not necessary to re-file or re-attach the documents to which 
you are linking to if they have been previously filed in CM/ECF. 

 

Inserting CM/ECF links into your document—Corel WordPerfect 
To manually add the links you have copied from the docket to the WordPerfect 
document you are drafting: 

STEP ACTION 

1 In the brief, use your cursor to select the citation you want to link. 
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STEP ACTION 

2 From Tools on the menu bar,  

select Hyperlink.  

3 A Hyperlinks Properties dialog box will appear.   

 

Use the Delete key 

from the computer 
keyboard to remove 

 

document> 

 

4 Right-click in the 
Document/Macro box. 

 

Select Paste. 

 

5 The link to the first page of 
the filing will appear.   

To link to the filing only, or 

to only page 1 of the filing, 
click OK.   

The link to the citation will 
be added in your brief. 
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STEP ACTION 

6 To link to the specific page number of a CM/ECF filing to which you 
are citing,  

In the address box, scroll to or place your cursor at the end of the link 
address. 

Add the following text: ?page=<page number> .  For example, 

 

To link to page number 3 of a filing, add ?page=3.  Click OK and the 
link to the page will be added to the citation in the brief. 

Note:  While the document remains in WordPerfect format, the link will 

go only to the first page of the document.  But upon conversion to 
PDF, the PDF link will go to the specific page you cited. 

7 Convert the brief to a PDF following the instructions below. 

8 File the PDF version of the document in CM/ECF. 

Note: It is not necessary to re-file or re-attach the documents to which 
you are linking to if they have been previously filed in CM/ECF. 

 

Links to Attachments to a Brief being Filed in CM/ECF 

Adding Links to Attachments to a Brief being Filed—Microsoft Word 
If a document cited in your brief has not previously been filed on CM/ECF, you 

may link to the document within your brief only if the document is filed as an 
attachment to your brief. Follow the steps below to add active hyperlinks to 
documents you will be filing as brief attachments in CM/ECF. 

STEP ACTION 

1 Save all the attachment documents you will cite in your brief into a 
single folder in your computer. The documents must be in PDF format. 
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STEP ACTION 

2 While drafting your brief, include the citations to the documents saved 
in your computer.  

3 Using your cursor, select the text to which a link will be added. 

 

4 On the Insert 
ribbon,  

select Hyperlink. 

 

5 In the Insert Hyperlink dialog box: 

 Navigate to cited file saved on your computer;  

 Select the file; and  

 Click OK. 

6 A link to the file will be added to the text. If you hover over the link with 

your cursor, you will see the link address. 

 

Add links accordingly to all the citations in your brief. 

Note: Specific page links can be added by following the directions in 
the previous section. Use the PDF page number, not a Bates number 
or footer page number, for the citation. 
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STEP ACTION 

7 Save the brief as a PDF as described in these instructions. 

8 File the brief and evidence as follows: 

a Following the normal procedure for filing briefs on 

CM/ECF, browse to and select your brief with links as 
the main document. 

 

b Browse to and select as an Attachment each PDF file 

to which a link was created in your brief.

 

c Using the drop-down list, select the type of document 

attached, and provide a written description of the 
document.   (Note:  From the court’s perspective, the 
written description you provide in CM/ECF can 

become, automatically, the name of a PDF bookmark in 
the downloaded file).   

 

 

R
e

Repeat the foregoing steps until all cited evidence is 
filed as an attachment to your brief. 

d When all evidence attachments have been added to 

the brief, click Next and complete the remaining steps 

for filing the brief on CM/ECF. Once filed, the links in 
the brief will link directly to the evidence filed of record 
as attachments to the brief. 
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Adding Links to Attachments to the Document Being Filed—WordPerfect 
If a document cited in your brief has not previously been filed on CM/ECF, you 
may link to the document within your brief only if the document is filed as an 

attachment to your brief. Follow the steps below to add active hyperlinks to 
documents you will be filing as brief attachments in CM/ECF. 

STEP ACTION 

1 Save all the documents you will cite to into a single folder in your 
computer. The documents must be in PDF format. 

2 While drafting your brief, include the citations to the documents saved 
in your computer.  

3 In WordPerfect, select the text to which a link will be added. 

 

4 From the Tools menu, select Hyperlink. 

5 A Hyperlinks Properties dialog box will appear. 

Click the folder button. 
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STEP ACTION 

 Browse to and select the saved file you want to link. 

 

Click on the file.  The name of the file will appear in the File name box.  
Click Select.  

(Note: The file selected as the link must be in PDF format.) 

6 The path to the file will appear in the Document/Macro field. 

 

7 A link to the file will be added to the text. If you hover over the link with 
your cursor, you will see the link address. 

 

Add links accordingly to all the citations in your brief. 

Note: Specific page links can be added by following the directions in 
the previous section. Use the PDF page number, not a Bates number 
or footer page number, for the citation. 
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STEP ACTION 

8 File the brief and evidence as follows: 

a Following the normal procedure for filing briefs on 

CM/ECF, browse to and select your brief with links as 
the main document. 

 

b Browse to and select as an Attachment each PDF file 

to which a link was created in your brief.

 

c Using the drop-down list, select the type of document 

attached, and provide a written description of the 

document.  (Note:  From the court’s perspective, the 
written description you provide in CM/ECF can 
become, automatically, the name of a PDF bookmark in 
the downloaded file).   

 

 

R
e

Repeat the foregoing steps until all cited evidence is 
filed as an attachment to your brief. 

d When all evidence attachments have been added to 

the brief, click Next and complete the remaining steps 
for filing the brief on CM/ECF. Once filed, the links in 

the brief will link directly to the evidence filed of record 
with the brief. 
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Links to Legal Citations 

 Links to legal citations can be added manually or, assuming the software is 

compatible with your computer and word processing software, by using automated 
linking software available through Westlaw or Lexis.   

Access to Linking Software 

Tool Cost URL 

Westlaw InsertLinks Must purchase a West 
BriefTools subscription. 

Estimated cost:  $100/month 
for small firms; 

$300 to 500/month for larger 
firms (10 licenses) 

http://legalsolutions.thomsonre
uters.com/law-
products/solutions/brief-
tools?searchterms=brief+tool 

 

Shepard’s Links 

2008 

Lexis is currently not selling a 

software subscription which will 
insert links to documents that 

will remain active upon 
conversion to PDF.  The last 
version of such software was 

created in 2008 and can be 
downloaded from the 
Lexis/Nexis website for free. 

http://support.lexisnexis.com/ln
download/record.asp?ArticleID
=6056 

 

Note: The Shepard’s 
BriefSuite dictionary is getting 
old and may not recognize 
some of the newer reporters. 

Its accuracy as a linking tool is 
inconsistent.  

Lexis for Microsoft 

Office  

This Lexis software product will 

add links for research and 
drafting purposes, but those 
links are lost upon conversion 

to PDF.  Lexis is investigating 
the issue. 

http://www.lexisnexis.com/en-
us/products/lexis-for-microsoft-
office.page 

 

  

http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
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Linking Software—Compatibility Information 
The following graph outlines the compatibility of Shepard’s Links 2008, West 
InsertLinks, and Lexis Links for Microsoft Office for inserting links into MS Word 

and WordPerfect documents with a Windows XP (SP3) 2GB Memory, Windows 
Vista (SP2) 4GB Memory, or Windows 7 – 4GB Memory computer.* 

 Shepard’s Links 
2008 

Lexis for 
Microsoft Office 

West 
InsertLinks 

MS Word 2010  X** X*** 
    

MS Word 2007  X** X*** 
    

MS Word 2003 X  X*** 

    
MS Word 2000 X   
    

WordPerfect X6****    
    
WordPerfect X4 – X5   X 

    
WordPerfect X3  X  X 
    

WordPerfect 10 – 12 X   

*    The West and Lexis linking software programs cannot be used on Apple computers.  
Moreover, although Shepard’s Links was not designed to operate on Windows Vista 

and Windows 7 (as reflected in the Lexis literature), it is working on these computer 
systems.   

** Lexis for Microsoft Office is being developed and tested.  However, in its current 
stage of development, any links added by Lexis for Microsoft Office are being stripped 
out upon conversion to PDF.  Lexis is investigating this issue. 

*** Westlaw product information states InsertLinks is compatible with both 32- and 64-bit 
Microsoft Word.  However, while it works well with 32-bit Word, InsertLinks is not fully 

compatible or useful with 64-bit Word.  

**** West currently has no linking software compatible with WordPerfect X6.  West 

indicates it may develop and release this product during the summer of 2013. 
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Westlaw InsertLinks 
InsertLinks is a Westlaw computer software program which scans Microsoft Word 
or Corel WordPerfect2 documents to locate legal citations, and then automatically 

inserts hyperlinks to the Westlaw internet address (url) for those citations into the 
word processing document.   

See attached InsertLink example-Word  

InsertLink example-WordPerfect 

Installing Westlaw InsertLinks  
InsertLinks is part of the West BriefTools suite, and a BriefTools 

subscription is required in order to use this software. 

 The current West BriefTools product is Version 2.7.2039, which 
was updated on December 10, 2012. 

 The attached BriefTools Software Download instructions  
outlines the system requirements and provides instructions on how 

to install West BriefTools. 

Using West InsertLinks—Microsoft Word 
Once InsertLinks software is installed, Westlaw links can be installed 
automatically in Microsoft Word documents using the following steps:  

STEP ACTION 

1 With the Microsoft Word document to which you are adding 

links open on your screen: 

 

Select the Westlaw Solutions tab on the Word ribbon. 

2 The West BriefTools options will open. 

 

 Select InsertLinks. 

                                                   
2
 Currently, InsertLinks is not compatible with, and cannot be used for, automatically inserting links into 

WordPerfect X6 documents.  It does, however, work with prior versions of WordPerfect.  
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STEP ACTION 

3 The InsertLinks software will begin searching the document 
for citations and inserting the appropriate links. 

 

 

The box depicted above will disappear when the process is 
complete and all links are installed. 

 

Using West InsertLinks—Corel WordPerfect 
Once InsertLinks software is installed, Westlaw links can be installed 
automatically in WordPerfect documents using the following steps:  

STEP ACTION 

1 With the WordPerfect document to which you are adding links 

open on your screen: 

 

Select Insert Links from the menu bar. 
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STEP ACTION 

2 The InsertLinks software will begin searching the document 
for citations and inserting the appropriate links. 

 

3 The Inserting Links box depicted above will disappear when 
the process is complete and all links are installed. 

 
 

Shepard’s Links 2008 
Shepard’s Links is a Lexis computer software program which scans Microsoft 
Word or Corel WordPerfect3 documents to locate legal citations, and then 
automatically inserts hyperlinks to the Lexis internet address (url) for those 

citations into the word processing document.   

Reminder:  Although free, Shepard’s links has not been updated since 2008 and 
provides inconsistent auto-linking results. 

Installing Shepard’s Links  
Shepards Links is part of the Shepard’s BriefSuite. 

 Shepard’s BriefSuite has not been updated since 2008. 

 The attached BriefSuite software download instructions  
provides a step-by-step description on how to install Shepard’s 

BriefSuite.  

  

                                                   
3
 See compatibility graph above.  
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Using Shepard’s Links— Corel WordPerfect 
Once Shepard’s Links software is installed, Lexis links can be installed 
automatically in WordPerfect documents using the following steps:  

STEP ACTION 

1 Click on the Shepard’s Link button, circled in the screenshot 
below 

 

2 Click the checkbox (optional) and click OK. 
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STEP ACTION 

3 Click Cancel.  Logging in is optional. 

 

4 Click OK. 

 

5 The new document with the hyperlinks opens in a new tab.  

Save the document as a PDF as described in these 
instructions. 
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Manually Inserting Hyperlinks  

As previously described, hyperlinks to documents filed on CM/ECF can be 

manually added to a document.  It is also possible to manually create links to 
documents available through commercial legal websites (e.g., Lexis or Westlaw), and 
those posted on the court’s website (Local Rules).   

Manually adding links can be labor intensive if the document is long, but the 
process is not difficult.  And even if you are primarily using software to add links to a 
document, understanding the underlying mechanics of hyperlinking within WordPerfect 

and Word documents is helpful and may be necessary if, for example, you need to 
make corrections to the automatically created links. 

Manually Creating Links to Online Research Resources 
The process for manually adding links to Westlaw, Lexis, Google Scholar, or any 
other online research resource (LoisLaw, FastCase, etc.,) is essentially the 

same. 

STEP ACTION 

1 In the brief, use your cursor to select the citation from which you want 
to link. 

 

2 Sign into the legal research website and open the cited document. 

Select the url address for the document. 

Right-click, and Copy the address.  See e.g.,  

 

OR 

 

OR 
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STEP ACTION 

3 For Microsoft Word documents: 

a 
Select the Insert ribbon, then select Hyperlink. An Insert 
Hyperlink dialog box will appear. 

 

Note: The text you selected will automatically appear in the “Text 
to display” line. 

b Place your cursor in the Address box of the Insert Hyperlink 

dialog box. Right-click. From the drop-down that appears, 
select Paste. 

 

Click OK.  

c 
The link to the citation will be added in your brief. 
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STEP ACTION 

4 For WordPerfect documents: 

a From Tools on the menu bar,  
select Hyperlink. 

b 
A Hyperlinks 

Properties dialog box 
will appear.   

Use the Delete key from 
the computer keyboard 

to remove

 

c 
Right-click in the 
Document/Macro box. 

 

Select Paste. 

 

d Click OK.   

 

e The link to the citation will be added in your brief. 
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Manual Links to Court Websites 
You may wish to cite to published opinions on a court’s website, or to the court’s 
local rules.  To do so: 

STEP ACTION 

1 In your brief, select the text to be linked. 

 

2 Locate and copy the url address for the citation.  See e.g.,  

 

OR 

 

3 Referring to the previous section, “Manually Creating Links to 

Online Research Resources,” 

 for Microsoft Word documents,  complete Step 3; and  

 for WordPerfect documents, complete Step 4.  
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Publish to PDF—Retaining the Hyperlinks 

All documents filed in CM/ECF are PDFs, so all documents created for filing must 

be converted to a PDF document.  To include hyperlinks in your filed documents, place 
all the links into the document using your word processing system before converting the 
document to a PDF format. 

Once all links are in the document, use your word processing software to save or 
convert your briefs, or other documents you have created for filing, in a PDF format.   

Note:  Do NOT use Print to PDF to create a PDF of a brief with hyperlinks–the 
hyperlinks will be lost.  Do NOT print the document and scan it to PDF format. 

Conversion to PDF—Microsoft Word 
MS Word has several methods for saving (“publishing”) a document in PDF 
format, including the following methods: 

STEP ACTION 

1 Select the File 

tab on the MS 
Word ribbon; 

 

from the drop-

down menu, 
select  

Save and 
Send; 

and from the 
choices now 
available,  

choose 
Create Adobe PDF from the File Types list,  

then   
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STEP ACTION 

2 Navigate to the location where you want to save the document. 

Name the document and click Save. 

 

Check View Result if you want the PDF document created to open 
upon conversion. 

3 After the document is published to PDF, you may upload it to CM/ECF 
using typical filing processes.  With the exception of filing a document 

with links to its own attachments (discussed previously), no special 
steps are needed for filing a hyperlinked document on CM/ECF. 

Note:     You may also add the Adobe Acrobat tab to your MS Word ribbon and 
use that tab to convert documents to PDF. 

Select the File tab on the MS Word 

ribbon. 

Choose Options.  
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Select 

Customize 
Ribbon. 

Add the 
Acrobat tab. 

Click OK 

An Acrobat tab will now appear on the MS Word ribbon, and 
will continue to do so hereafter. 

 

After the Acrobat tab is added, save a document as a PDF by 
selecting the Acrobat tab, and then Create PDF. 

 

After the document is published to PDF, you may upload it to 

CM/ECF using typical filing processes.  With the exception of 
filing a document with links to its own attachments (discussed 
previously), no special steps are needed for filing a hyperlinked 
document on CM/ECF. 
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Conversion to PDF—Corel WordPerfect 
To save (“publish”) a WordPerfect document in PDF format: 

STEP ACTION 

1 Select File –> 

Publish To –>  

Publish to PDF. 

 

Or 

 

Type Alt + P. 

2 The Publish to PDF dialog 

box will open.    

Browse to the file location 
for saving the file. 

Name the file.   

Click Save.   

A PDF will be created with 
active links.   

 

3 After the document is published to PDF, you may filed it on CM/ECF 
using typical filing processes.  With the exception of filing a document 

with links to its own attachment (discussed previously), no special 
steps are needed for filing a hyperlinked document on CM/ECF. 

 

 This Guide was produced through the collaborative efforts of judges, 
IT and Clerk’s office personnel, educators, and library staff.  Please 
share your comments, questions, corrections, and experiences with 

hyperlinking or using this Guide by contacting: 
 

 Cheryl Zwart, United States Magistrate Judge—Nebraska 
cheryl_zwart@ned.uscourts.gov 

(402) 437-1670  

mailto:cheryl_zwart@ned.uscourts.gov
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